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1 About FusionWorks UC One 

FusionWorks UC One is a native Windows or Mac client for Unified Communications, providing the 
following communication features: 

 Instant Messaging and Presence

 Voice Calling (VoIP)

 Voice Calling (Desk phone)

 Video Calling

 Desktop Sharing

 Call Settings
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2 Get Started 
2.1 Installation 

Windows 

1. Double-click the installer executable file, and follow the installation instructions.

2. Launch FusionWorks UC One.

OS X 

1. Double-click the disk image.

2. Copy the application into the Applications folder.

3. Launch FusionWorks UC One.

2.2 Sign In 

When you first launch the application, you are prompted to sign in. 

NOTE: If you choose automatic sign in, you are automatically signed in and taken to the 
Main window upon subsequent FusionWorks UC One launches. Otherwise, you are presented 
with the Sign In screen when launching the application. FusionWorks UC One remembers the 
tab you were on at sign out, and opens that same tab at sign in. 

NOTE: It is possible to run several FusionWorks UC One instances at the same time, but 
headphone connectors and Outlook integration may not work as expected. 

2.3 Main Window 

When you start FusionWorks UC One for the first time, your Contacts list is empty. Use the Search and 
Dial field to find people and add them to your Contacts list. Contacts can also be added manually by 
clicking the Add button. Client windows can also be set to always use the Main window menu option. 
The Dial Pad is also integrated with the Main window. 

1. Enter your Fusion Connect user name and password. For this, use your
"phonenumber"@megapathvoice.com and your Fusion Connect password supplied to you during 
provisioning. This is the same password you use to sign in to Fusion Connect Voice Manager.

2. Select whether you would like FusionWorks UC One to remember your password.
3. Select whether you would like FusionWorks UC One to sign you in automatically on subsequent 

launches.
4. Click Sign In.

mailto:
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FusionWorks UC One uses tabs for new chat sessions. The Search and Dial field allows searching for 
contacts as well as making calls using phone numbers. The table that follows the image below 
describes the key icons used in the Main and Communications windows.  

Figure 1 Main & Communications Windows 

Icon Usage 

My Information – View and update your information, presence status, avatar, and location. 

My Room – This is your permanent communication room. Participants can dial in to your audio bridge. 

Add Contact – Opens window for adding a new contact or a new group. 

Contacts – View your contact list. 

Call History – View previous calls. 

Chat History – View previous chats. 

Full Enterprise Directory – Show all contacts of the directory. 

Dial Pad – Opens the dial pad in the display area (main window) so you can make a call. 

Voice Manager Link – Opens a new web browser directly to the Fusion Voice Manager, where you can manage 
your service for out of office or other settings. 
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Options – Opens Options area. Use for quick access to set general preferences, audio/video equipment, and call 
settings like Call Forwarding. 

Chat – Start an instant message conversation with a selected contact. 

Call – Make an IP audio call to a selected contact. 

Call from Phone – Make a Click To Dial call from your desk phone (or secondary device). 

Video Call – Make a video call to a selected client (VoIP). 

Share – Share either the whole screen or an individual application. 

Menu – opens more communication options 

Figure 2 Icons and Meanings 

My Information 

 Click the avatar to update your status or location, and enter free text.

 Double-click the avatar to upload a picture, or use a right-click menu.

 Right-click the avatar to update your status

Presence 
You can set your presence to one status indicated in the following table. 

Icon What it means 

The green presence icon indicates that the user is online and ready for communication. 

The yellow presence icon indicates that the user is online but has been idle or away from their computer for more 
than 10 minutes. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

The grey presence icon indicates that the user is offline and the only available contact method is calling or leaving a 
chat message. 

This icon indicates that the contact is busy due to a call. This is an automated presence status. 

The icon indicates that the contact is busy due to a meeting. This is an automated presence status. The Busy – In 
Call status overrides the Busy – In Meeting status, so this one is only seen if there is a meeting but no call. 

Figure 3 Presence Icons and Meanings 

FusionWorks UC One can automatically update your presence to the following: 

 Busy – In Call

 Busy – In Meeting (Windows only)
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 Available (desk phone)

 Available (mobile)

 Away on mobile

 Offline and busy in call

Location 
Your location is automatically determined by your public IP address. However, you can manually set the 
text to appear for you location and time zone using the location dialog box. 

2.4 Communications View 

After starting communication with one or more contacts, a new tab is displayed for chat. The call 
window is also integrated with the Main window chat tab by default. You can separate a tab onto a 
different Communications window by dragging and dropping it outside of the Main window. From this 
view, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing

 End an audio or video call

 Open the dial page

 Mute your microphone

 Adjust your speaker volume

 Place a call on hold

 Transfer a call

 Toggle between speaker and headset

If you are using several monitors, FusionWorks UC One opens the Communications window as well 
as notification on the same monitor as the Main window. 

FusionWorks UC One limits the number of active communications to spare resources. The limit is 20 
active communications on Windows and OS X. If the maximum is reached, the main window’s top 
section warns user with the following message: “The maximum amount of communication windows 
has been reached. Please close some to open new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat session that has 
the longest time since its last activity. 

2.5 Start Chat 

Start a chat using one of the following methods: 

 Double-click a contact from the Contacts list or search results
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 Right-click one or more contacts from the Contacts list or search results, and click the Chat
menu item.

 Hover your mouse over a contact from the Contacts list to see their Contact Card. Click on the
Chat icon in the Contact Card.

 On the Chat History list, double-click a chat entry.

2.6 Send File 

In a one-to-one chat transfer files by clicking the Send File button in the Communications window 
(bottom), or use the “drag and drop” method so that the files are moved to the Communications 
window. 

2.7 Send Email 

Right-click a contact from the Contacts list or search results, and select the Email menu option. The 
contact must have an email address defined for this feature. 

2.8 Make Audio or Video Call 

Make an audio or video call using one of the following methods: 

 Right-click one or more contacts from the Contacts list or search results, and select the Call, Call
from Phone, or Video menu item.

 Enter a phone number in the Search and Dial field.

 Press ENTER to start a VoIP call.

 Click the Call, Call from Phone, or Video button.

 Open the Dial Pad, enter a phone number, and then click the Call, Call from Phone, or Video
button.

 On the Call History list, double-click a call entry.

 In the Communications window, click the Call, Call from Phone, or Video button.

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button.

NOTE: If dialing a phone number that requires additional dual-tone multi-frequency 
(DTMF) tones (for example, a conference bridge), you can type the numbers on your 
keyboard while the Communications window has focus, or open the Dial Pad in the 
Communications window. 

2.9 Share Your Application or Desktop 
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Share you desktop by following these steps. 

1. Click the Start Sharing button in the top of the Communications window (if share panel is not
visible). The Share button is shown by default in My Room also. The share selector window
opens.

2. Select the application to share, or the entire screen of a particular display, and click the Start
Sharing button.

2.10 Active Communications 

Active communications appear at the top of the Contacts list in the Main window. This area provides an 
easy view to see the people with whom you are communicating. The call is shown in the Active 
Communications are in the Main window (where the call can be fully controlled in the Desktop client). It 
reduces the number of Communications windows; however, a separate call window can still be opened 
using an Active Communications menu. The following is also available in this area: 

 Double-click an active communication item to bring this tab into focus if the call window is
separately shown. If the call window is integrated, you can use a menu option to show it
separately.

 See who has sent you a chat message, but only after you accept the chat session. Before the
chat session is established, the chat items are not visible in active communications but a history
badge is visible.

 End a call.

 Mute the microphone.

 Place a call on hold.

 Merge two calls or transfer by dragging and dropping calls onto each other.

 Transfer a call.

 Make conference calls.

 Park and retrieve calls.

 Set audio device to headset or speaker.

 Conference

 Call Transfer

 Call Park

 Call Pull

When enabled, you can use these buttons for faster access to services. You can right-click the More icon 
(three dots) of an active Communications item to access more options. A left-click offers additional call 
management options for this call, and other options when available. 
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2.11 My Room 

My Room is an always available and permanent you can use to chat with anyone that joins. 

You can invite others to your room by dragging and dropping them from Contacts into My Room. You 
can also use the right-click menu on the My Room icon in the top-right corning of the Main window, or 
My Room information area to copy an invitation link for guest users (people without FusionWorks UC 
One). They can then click the link and join the meeting through a web browser. Guest users must be 
separately accepted for each session. 

Contacts join your room by right-clicking your name on their contact list and selecting Join Room or by an 
invitation you sent. 

Email My Room Invitation menu results in working links for guest users only. FusionWorks UC One users are 
recommended to use Copy My Room Invitation links; however, the links may not work in all applications as 
they were originally intended for Outlook. 

You can also export the attendee list using the related participant menu available via the options icon (three 
dots). 

In My Room calls, the owner can also see active speaker info with the Mute/Unmute icon. My Room can also 
be moderated, for more information on moderation, see Section 6.14 Moderator Controls. 

2.12 Select Audio Devices 

If you have multiple audio devices available for your microphone or speakers, select the preferred audio 
device before starting a call. 

Windows and OS X 

1. Select Options.

2. Select Audio/Video.

3. Set a playback device (speakers).

4. Set a recording device (microphone).

5. Click OK.

If “Use default” is selected, then FusionWorks UC One uses the default device set in the operating 
system preferences. For Windows, if “Default Communication Device” is defined, it is selected over the 
“Default Device”. If you are using headsets, you can also select a separate device than the headset for 
alerting incoming calls. 

Note that on OS X it is recommended to disable “Use ambient noise reduction” in System Preferences to 
reduce echo. 
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3 Contacts 

Contacts are the people with whom you communicate and, in most cases; you see their presence and share 
your presence with them. There are two types of contacts: 

Contacts – Actual people with whom you communicate. 
Groups – Containers of contacts.  

There is no hard-coded limit on the number of contacts. The more contacts are added the more memory 
and processing is needed. The more contacts are added, the more difficult it is to find people without 
searching. Live search can be used instead of a very large local contact list while keeping memory and 
processing requirements to a minimum. 

3.1 Add 

When you sign in for the first time, there are no contacts on your contact list. Add a new contact at any time 
by selecting the Add Contact item from the menu or choose the Add button from the Main window (+ icon). 
In the resulting tab, you can select to add a contact, group, or other items. 

In the Add Contact tab, enter the contact’s information and then click Save. By default, your presence 
information is always shared with a new contact if an Extensible Messaging and Presence Protocol (XMPP) 
address is provided. 

If you are accepting contacts via a buddy request, you may see the contact card after accepting the buddy 
request, depending on the service provider settings. When receiving a buddy request, there are two buttons 
for accepting and rejecting the request. 

Dismissing the buddy request window only ignores the request for the duration of the login session. It 
reappears after the next login. 

However, you can always share your presence information later by selecting Subscribe on the right-click menu 
for a specific contact in the contact / directory list. Note that the contact must accept your subscription 
request for you to establish the presence relationship successfully. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button you did for Add Contact. A conference contact is a 
special contact used for conference bridges to avoid remembering PIN codes and conference number, for 
example, recurring conferences. Just create a contact for the weekly conference, add a conference bridge 
number and PIN, and join the conference just by right-clicking the contact or choosing it and clicking the Call 
button. 

Choose the Add Group menu option to add a new group to the contact list. 
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Contact card telephone number fields can also have SIP URIs (work, mobile, extension, personal, and 
conference bridge).  

3.2 Edit 

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in the area 
of the selected contact and a menu of options appears which allows you to either view or edit the contact 
profile. In View mode, click the Edit button to go to Edit mode. This base principle is the same for normal 
contacts, conference contacts, and groups.  

 Unsubscribe removes the presence relationship between you and that contact. This means you
do not see the contact’s presence information and your contact does not see yours. To re-
establish the presence relationship, select Subscribe. An unsubscribed contact remains on the
contact list and is always shown without an icon. Any contact that is not presence-enabled is
shown in the same way. 

 Delete contact removes the contact from your contact list.

 View Profile opens the Contact Information dialog box where you can add, edit, or remove
information. This works for both normal and conference contacts.

 For groups, choose the Edit menu option to rename a group.

Once done with all changes, click the Save button. 

3.3 Filters 

You can filter contacts in two ways: 

1. Use the filter field (also called Search & Dial) to search by contact name. The contact list is filtered in
real time as you type.

2. Alternatively, use the filter menus available by right-clicking the Contacts icon in the left pane to
display only specific types of contacts such online. You can also sort contacts based on first or last
name or choose whether to display the contact’s avatar and availability status in the contact list.

Favorite filtering works slightly differently: 

 When you make a contact your favorite, the favorite group shows on top of the contact list and
cannot be hidden.

 When you delete all your favorite contacts, the favorite group does not show anywhere.

 When you have even one favorite marked, you see the group.
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4 Presence 

For each contact you have subscribed to, you can see their presence. Similarly, your contacts can see 
your presence on their contact list.  

Presence means that your coworkers can see whether you are available to communicate, for example 
“I’m busy” or “I’m available.” 

Icon What it means 

The green presence icon indicates that the user is online and ready for communication. 

The yellow presence icon indicates that the user is online but has been idle or away from their 
computer for more than 10 minutes. 

The red presence icon indicates that the user is busy and does not want to be disturbed. 

The grey presence icon indicates that the user is offline and the only available contact method is calling 
or leaving a chat message. 

The question mark icon indicates that a subscription is pending and the contact has not yet approved 
sharing their presence. 

This icon indicates that the contact is busy due to a call. This is an automated presence status. 

The icon indicates that the contact is busy due to a meeting. This is an automated presence status. The 
Busy – In Call status overrides the Busy – In Meeting status, so this one is only seen if there is a meeting 
but no call. 

This icon indicates that the contact is only available on mobile FusionWorks UC One. 

This icon indicates that the contact is only available on a compatible desktop phone, and not 
FusionWorks UC One.

This icon indicates that only the mobile client is online and in the Away status. 

This icon indicates that the user is in a call but is not logged in to XMPP (presence and chat). 
Figure 4 More Presence Icons and Meanings 

The avatar is not completely in real time. Avatars are retrieved at login, when the contact is added, and 
when the contact comes online. Double-click the avatar to change your avatar image. A File Explorer 
view will open so you can upload your new image. 

If you see an error message at the top of the Main window “XMPP Unavailable,” it means that the 
XMPP connectivity has been lost for Chat and Presence; however, you can still make calls. Contact 
Fusion Connect for more assistance. 
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Have the Outlook calendar automatically change your presence to Busy – In Meeting by enabling this in 
the Options → General area. 

The presence update is only triggered by appointments and meetings that are in the Show me as busy state. 

The XMPP address of a contact cannot be changed. Instead, you must delete the old contact and create a new 
one. 

Location in presence is done based on the IP address that the machine is using on Windows. The IP address is 
mapped to a physical location. Fusion Connect is working with the mapping provider to improve location 
accuracy. On OS X, the operating system location is utilized. You will be prompted to accept location usage. 
Change the location manually by clicking on the avatar (If presence controls are not already expanded) and 
then the location icon to go to the manual location and change the view. 

Snapshot of presence status is also available in search results and Communications window for contacts who 
are not buddies. This presence status is not updated after the search is done, or after the communication 
session is set up.  
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5 Chat 

5.1 Chat View 

When you initiate a chat, the Chat tab inside the Main window opens. Chatting with a contact is possible 
only when you are both online. If your contact initiates a chat, you see a pop-up notification in the 
bottom right-hand corner of the screen. If you close the Chat tab and open it again, sent chat messages 
are shown in the tab as chat history.  

When the chat opens, you see the contact’s information at the top of the screen. 

At the top of the message area, there are five links: Yesterday, Last Week, Last Month, All History, and 
Delete History. From these links, you can load history from your local storage and different timeframes. 
Depending on your history, some links may not be visible if there is no data to show.  

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by manually entering 
the corresponding characters that represent that particular emoticon. You can send text by pressing 
ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when received. Spell 
checking is also supported and can be disabled in Options.  

To enter a line break in the text field, you can use the following key commands: 

 CTRL+ENTER (command+enter on Mac)

 SHIFT+ENTER

 ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a menu to copy or 
paste the text to or from the Chat tab. 

5.2 File Transfer 

File transfer functionality is only accessible through the Chat tab. 

1. To open the File Selection dialog box, click the Send File button located to the side of the text field.

2. From the dialog, select the file to be sent, and then click Open. You can also drag and drop a file
into the Chat tab.

3. Once the file offer is issued and during its transfer, you can cancel the transfer (at any time) by
clicking Cancel.

4. Accept an incoming file transfer by clicking the Accept button.

5. Reject the file transfer offer by clicking the Decline button.
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After the file transfer has completed, the received files can be opened or viewed in the file manager by 
using the File received, click to open, and Show in folder links. 

In error situations, partially received files are not deleted automatically. 

5.3 Group Chat 

Start a group chat by “multi-selecting” and right-clicking the Main window contact list. More people can be 
added later to the chat by “drag and drop”. Only the owner can add more participants.  

A group chat works the same way as a one-to-one chat in a tabbed view. All messages from anyone are sent 
to everyone else. All contacts need to be online to be able to participate in a group chat. You cannot invite an 
offline contact or a contact that is not on a device that supports group chat. This does not affect the group 
chat in any way. 

A group chat history is saved both in My Room and in ad hoc chat rooms and is available to view later in the 
Messages tab of the Main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish between who is writing. 
Only the newest chat room messages are stored on the server. One-to-one chat messages are only saved 
locally. When the optional Message History feature is enabled by your service provider, messages sent from 
your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner. Use the right-click menu options to remove a participant from 
your chat room. If needed, the removed participant can join later. The removal also applies to desktop share 
sessions. 

Typing notifications are not supported in group chats. 
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6 Audio and Video Calls 

The following table describes additional Communications window icons, and explains what you can do 
with them for voice and video calls. 

Icon What You Can Do 

Add or remove video from the call. 

Mute your microphone by clicking the mute button. 

Put the call on hold. Note that if you hold the call, the other party cannot “unhold.” This freezes a video 
call to the last frame of the video feed. In both voice and video calls, this is communicated to all parties 
by a notification appearing in the middle of the screen. 

Use this icon to access the Call Options menu. 

Figure 4 Audio/Video Icons and Functions 

In the Options menu, you can do the following: 

 Transfer a call to a third party

 Put the call on hold. Note that if you hold the call, the other party cannot “unhold.” This freezes
a video call to the last frame of the video feed. In both voice and video calls, this is
communicated to all parties by a notification appearing in the middle of the screen.

 Adjust the volume using the volume bar. Drag it to the far left to mute your speakers.

 Enter additional digits using the dial pad at any time during the call (for example, to insert a
conference number). The dial pad is not movable.

 Toggle between audio headset and speakers.

 Add participants to the call.

As an alternative, in general available Feature Access Codes (FACs) for call management work during 
calls. For instance, *55 for direct transfer to voicemail, but the ongoing call must be put on hold and a 
new call must be made to the FAC “number.” Using DTMF for the same purpose does not work. 

When establishing a call to a contact, you can choose several ways to call. Right-click the contact you 
want to call and select the Call menu item. Choose the number to call from a right-click menu. There can 
be several phone numbers associated with a single contact, and thus available in a menu. Work phone is 
the default and top-most number. Mobile and other numbers are shown beneath it. This set up applies 
to the transfer and conference windows. However, in certain cases, the transfer/conference default 
number can differ from other call options in other menus. 

The default call type can be selected using accessibility menus (Calls → Dialing service.) This controls the 
default call type when using call buttons. 
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Dial a number of SIP URI of format user@domain or sip:user@domain in the combined Search and Dial field to 
make a call. Once you type your numbers, FusionWorks UC One searches for contacts on both the local list 
and enterprise directory. 

Choose your video size from the Options → Audio/Video section. Your selection is used by default for 
future video calls. The available sizes are automatically presented based on your camera. 
You cannot have two simultaneous calls with the same person. 

FusionWorks UC One does not add video to an audio call without end-user consent. This also applies to 
blind video call transfer cases where audio-only music on hold is used; this may result in the transferred 
call being reduced to audio. 

You can also see a secure call icon when an encrypted call is taking place. 

NOTE: There is sleep prevention during calls. 

6.1 Call From Computer 

Select a contact form your Contacts list to start communication and click the desired communication 
button. To communicate with someone who is not on your contact list, type a phone number in the 
Search and Dial field. 

6.2 Call From Phone 

In the row of communication buttons, the second option is Call form Phone. When you click this button, 
the desk phone instantly starts ringing and the call is established from your desk phone. 

For remote calls initiated using FusionWorks UC One, you can also have mid-call controls such as hold/
resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

6.3 Answer Call 

When someone is calling you, you see a pop-up notification on your screen. You can choose to answer, 
silence the incoming call, and then open a chat session with the caller, reject the call, or silence the 
incoming call by closing the pop-up notification window. If you silence the call, the ringtone is silenced 
but the caller does not see anything on their end. You can answer or reject the call after silencing it only if 
you have chosen the chat option. If you close the incoming call pop-up notification to silence an incoming 
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call, then you do not have an option to answer or reject it any more. When choosing the chat option, chat 
is only enabled after the call has been answered or rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that you rejected the 
call. 

When someone is calling you with a video, you see the same pop-up notification; however, the options 
are answer with video, answer as voice only, silence and chat, reject, or silence (by closing the pop-up 
window). If you decide to answer as voice only, the call is voice only. 

6.4 Contact Name Lookup for Incoming Calls 

FusionWorks UC One performs a local contact search for incoming calls. If the number matches one of 
the contacts on the FusionWorks UC One contact list, the name is shown on the incoming call screen 
along with the alert. Both the display name and phone number are shown when available.  
If there is no match to a local contact, FusionWorks UC One looks for a match in the Enterprise Directory 
and other available directories, and if a match is found, the available information is shown for the 
incoming call. If there is no match in the Enterprise Directory, the display name is taken from the available 
information in the incoming call. 

Whenever you retrieve your call logs/history, FusionWorks UC One does a lookup in the local contacts 
and populates the name if a match is found. 

6.5 Missed Call or Communication 

When you have one or more missed calls or other types of communications, there is a notification on the 
left-hand side of the navigation pane in the Main window. Clicking the icon takes you to the missed 
communication in the Communications History view. 

6.6 Full Screen in Video Call 

Full screen mode can be activated by clicking the Full Screen button or by double-clicking anywhere on a 
video. 

Exiting full screen mode is done by pressing the Esc key (on both Windows and OS X) or by double-clicking 
the window. Exiting full screen makes the video call go back to its original state (even if there was resizing 
of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top. It has the same functionality as it 
does in the normal view. When you move the mouse, the top bar and lower communication buttons 
appear on top of the video. 

6.7 Multiparty Sessions 
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You can have many participants in a call, either in a My Room or in an ad hoc multiparty call. Add more 
participants by dragging and dropping them on to the Communications window or by selecting the 
Conference menu item via the Communications window menu button. By choosing the menu item, you can 
also add participants with just a telephone number.  

In contrast to using My Room, which uses your permanent chat and collaboration rooms and conference 
bridge, you can start ad hoc multiparty sessions by either selecting multiple contacts on the contact list and 
starting a chat, by calling them, or by expanding a one-to-one session into a multiparty session by dragging 
and dropping a contact into the Communications window. In an ad hoc session, the room used is a temporary 
one that is deleted once the session ends (that is, when the last participant leaves). Voice conferencing does 
not use a bridge but instead uses the N-Way Calling supplementary service in a sequential fashion. 
FusionWorks UC One dials out to all participants and takes everyone off hold after the last attendee answers. 

If the XMPP service is not available, then ad hoc multiparty calls are not available. 

6.8 Call Waiting 

You can have one active call at any one time if you receive a new incoming call and accept it. The existing 
call is put on hold and you can change between these two calls by using the Hold and Unhold buttons. 

6.9 Call Transfer 

Blind call transfer is available in the Communications window; choose the Transfer Call menu item to 
transfer the call to someone else. Attended call transfer is also available in the same window, first call 
someone to check if the called party can take the incoming call and then transfer the incoming call to the 
desired called party. You can also search for the transferred-to party. 

6.10 Message Waiting Indication and Visual Voicemail (Preview) 

The Message Waiting Indication (MWI) service allows you to receive a notification for a waiting voice mail or 
video mail. By clicking on the message icon in the upper part of the Main window, FusionWorks UC One calls 
the predefined mailbox number to allow the user to listen to the voice mail or view the video mail. With this 
view, you only have two history tabs: one for calls and another for chat. 

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the dialer. 

6.11 Call Park and Retrieve 

Call Park is particularly suited for shared environments where one person can answer the call, park it, do 
something else for a while and continue the call from another device or let somebody else continue the call. 

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed. An ongoing call can be 
parked against your own number or another number (an extension). Call Retrieval works in the same way, 
the parked call can be retrieved from your own number (an extension) or another number (an extension) to 
provide flexibility for who is picking up the parked call. 
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A parked call is visible on your desktop in the Active Communications area so that you can easily retrieve it, 
but only for the duration of the Call Park announcement. 

After the announcement is over, the parked call disappears from the Active Communications area (since 
the triggering call is disconnected). After the call disappears from the Active Communications area, the user 
must remember the extension to which the call has been parked to retrieve it using the Main window 
menu (or feature access code), unless the call was parked to the one’s “own” extension. If the call is not 
retrieved after a certain time, then the server calls the parking user. 

6.12 Call Pull 

Call Pull allows you to pull an ongoing call from one of your devices to another one where the Call Pull 
feature is used. Call Pull can also be used with FACs, in this case, *11. User interface support has been 
added to the Desktop so that an end user does not have to remember FACs.  

6.13 Call Recording Controls 

You can use call recording controls in this release (native Desktop only). Depending on your service 
provider’s configuration, call recording can be initiated when a call starts or dynamically during a call (and 
start, stop, pause controls may be available). Additionally, there is an audio indication that call recording 
is ongoing as well as a visual indication. 

Feature Access Codes can also be used to control call recording when enabled in the configuration. 
Recorded calls are accessed outside of FusionWorks UC One; that is, you cannot view them using the 
client. Call recording behavior is one of the following (this cannot be controlled in the client but in the self-
provisioning portal): 

 Always – recording indication (icon) in the Communications window as well as the Active
Communications UI.

 Always with pause/resume – recording indication (icon) in the Communications window as well as
in the Active Communications UI (only pause/resume menus available).

 Never – no indicators or menu options present.

6.14 Moderator Controls 

You can control the functionality available to participants if you are the owner of the session in My Room. 
You can do the following: 

 Dismiss one or more participants. This ends all sessions (group chat, audio, video, and share) 
when the participant is using FusionWorks UC One.

 Mute one or more participants.

 Lock or unlock the room (when locked, no additional participants can join).

 See active talker indication.
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 See full audio participant list.

 Choose who can join without separate authorization (moderated My Room):

o Require only guests to request access

o Require everyone to request access

o Allow everyone to join automatically

To invoke the features, you can use the right-click menus or you can click on the moderator control icons 
of a participant. Note that most features are not available via icons. To dismiss or mute all participants or 
lock the room, use the right-click menus available for your own icon at the top of the participant list. 

If you are not the owner, you can only see the XMPP (chat) participant list or the full participant list along 
with mobile participants. 

6.15 Forced Logout 

Depending on your service provider settings, you may see a pop-up saying that you have been logged out 
due to another instance of the client logging in. 

This feature allows FusionWorks UC One to track similar online client instances and only allow one of them 
to be online at the same time. When FusionWorks UC One notifies the client to log out, all connections 
are terminated and client returns to the login window. 

6.16 Headset Support 

You can control incoming and ongoing calls from a compatible headset. The feature set supported is 
answer/hang up as well as mute/unmute. Volume control operations are not reflected in the 
FusionWorks UC One UI. The following is a list of tested example devices, although other devices should 
also work: 

 Plantronics Voyager Edge UC

 Plantronics Savi 700 series

 Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx

 Plantronics Calisto 620

 Plantronics Voyager Legend UC

 Logitech H570e Mono

 Logitech BCC950

 Logitech Conference Cam Connect

 Jabra Biz 2300/2400

 Jabra Speak 510

 Jabra Pro 930 (wireless)
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 Sennheiser SC 230/260

 Sennheiser SP 20

 Sennheiser MB Pro1 UC

6.17 Presence Rules and Silent Alerting 

You can combine call processing with presence statuses. For instance, the “Busy” status can be combined 
with Call Forwarding so that when the “Busy” presence status is used, calls are forwarded. It does not 
matter how the presence status is invoked, via automation or manually. 

All presence statuses can have presence rules: 

 Available

 Busy

 Away

 Offline

The following call processing services can be used: 

 Silent alerting

 Call forwarding to number

 No rules

If presence rules are used, all your client devices should have this service enabled to avoid side effects. 
Silent Alerting is supported whenever an incoming call has that feature enabled. Silent alerting can only 
be enabled via presence rules in FusionWorks UC One but various settings can also be altered via web 
provisioning. 

6.18 Hide Communications Window Notifications and Tones 

FusionWorks UC One notifications and tones in the Communications window can be hidden. 
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7 Application or Desktop Share 

To share your desktop or individual application: 

1. In the Communications tab, click the Start Share button. This does not yet start the “share.”

2. Select to share your entire display or one of your open applications, and click Start Sharing.

3. The share widget appears to let you control share settings. Preview shows you what participants
are seeing, and Pause pauses the sharing.

4. To stop sharing, click the Stop icon.

While sharing, all other communications mechanisms are available. Participants cannot hide a share 
without closing the Communications window. Video call is also available while sharing. 

Desktop sharing works the same way in both My Room and in ad hoc sessions. For participants without 
FusionWorks UC One, use the separate Desktop Share Invitation link, if available, by right-clicking the My 
Room button. Share selector is not dynamically updated while the selector is open and minimized applications 
are not available in the list of applications to share. 

As a participant, you can also zoom in and out during the share. As the share owner, incoming message 
toasters are suppressed during share, but the missed message badge is incremented and the incoming 
message sound is played when enabled. 

If you are first in a video call and then start share, your own video is not shown due to limited space available, 
but you can make it visible using the Main window menu in the bottom right-hand corner by selecting “Show 
Own Video.” 

If you are using dual monitors, you can choose which monitor to share. You can check the primary monitor in 
the operating system settings. 

You can also remove desktop share participants. They are also removed from the group chat at the same 
time. If needed, the removed participants can join later. 

Depending on your service provider settings, you may have to provide desktop share credentials manually. 

In addition, participants can share when enabled by the service provider by clicking on the Share button; 
however, the room owner can prevent this at any time. Only one person can share at any one time in a 
session. Only one share at a time is supported if you have sessions with many users at the same time. Share 
passing is only supported in My Room. 

Participants do not have to take any action to accept the share invitation. It is automatically accepted. The 
same also applies to share passing. That is, the owner does not have to take action for the participant to start 
sharing. 

When video and share are used at the same time, the different views cannot be resized. Instead, the primary 
view can be selected from the bottom of the window via thumbnails. 
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8 My Room 

My Room is your permanent chat room, where you can combine desktop share, conference, and chat with 
one or many people (both with and without FusionWorks UC One). 

Open My Room by clicking the icon on the top right-hand side of the Main window. Or use the main 
navigation bar Conversations → My Room. 

There are several ways to add participants: 

1. “Drag and drop” from Contacts or Search Results
2. Send an invitation to FusionWorks UC One contacts and Guests (people without FusionWorks UC One)

Invitations can be sent from main navigation Conversations → My Room Invitations, or from within My 
Room at the top right using the email icon.  

Participants can join your room by right-clicking your name on their contact list and choosing the Join Room 
menu option. Once people have joined the chat room, they can click on the Call button of that window to join 
the conference. The room owner can also share their desktop. 

Participants can also share the desktop but only the owner can add more participants. This applies to both My 
Room and ad hoc sessions. 

Invitation Links 
Select Copy Guest Link to copy an invitation link to the operating system clipboard. Paste this link, for 
instance, to a meeting invitation email to allow FusionWorks UC One participants to join the conference in 
one click from, for example, Outlook, or Office applications. Note that some applications may not 
recognize the FusionWorks UC One (btbc:) link.  

You can also copy the My Room Invitation to the default email client (this text does not contain the 
FusionWorks UC One link) and go to the My Room preferences via a right-click menu option. 

The link has two parts: one for FusionWorks UC One users and another one for users with some other client. 
Depending on your service provider settings, the invitation can also contain a link to the desktop sharing 
session. The invitation always contains a dial-in number and PIN for users who do not have FusionWorks UC 
One. The desktop share link, when available, allows anyone to join a desktop share session from a standard 
web browser. In addition, the FusionWorks UC One group chat session is supported with the web 
collaboration session. For guest user links, see the next section. 

The My Room info area indicates the conference bridge details of your My Room. You can also export the 
attendee list using the related participant menu available via the options icon (three dots). 

More Information 
My Room uses your permanent chat room, permanent collaboration room, and conference bridge (audio or 
video). My Room is the only way to use the permanent rooms. Any other multiparty communications, such as 
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selecting multiple contacts, and right-clicking for a conference call, or dragging and dropping for a one-to-one 
chat, is done using ad hoc rooms. Ad hoc rooms are deleted once the session is over. 

All My Room sessions start as chats but call and/or share can be added to the session while in progress. File 
transfer and video conferencing are not supported in My Room or ad hoc sessions. 

You can also define that all users or only guest users need to be authorized to access My Room or that all 
users can automatically join. 

For more information on desktop sharing, see Section 7 Application or Desktop Share. Desktop sharing works 
the same way for both My Room and the ad hoc sessions. 

8.1 Guest Client 

Guest Client allows users outside of your company to join your full My Room session. To acquire the Guest 
Client, have the participant use their Internet access to go to Google Chrome Web Store, search for Fusion 
Connect, and select the FusionWorks UC One Guest Client Share plugin.  

Generate separate invitations for guest users using My Room right-click menu items as described in the 
previous section. My Room invitations are generated using separate menu items and are intended for 
FusionWorks UC One users. 

Guest users can join a session with audio in the web browser by requesting a callback using the provided dial-
in number and conference PIN as well as use group chat and sharing inside the web browser. However, guest 
clients do not have private chat possibility and they can see the chat history of messages that occurred after 
they joined the session. 

The invitations persist until reset via a separate right-click menu item. Individually accept each joining guest 
participant. Not doing this in a predefined period of time results in the invitation becoming obsolete and 
guests not being able to use the link to join. 

After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported: 

• Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 [Classic])

• OS X (10.8, 10.9, and 10.10)
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9 Search 

FusionWorks UC One supports a search of the enterprise directory as well as the personal directory, 
enterprise common directory, and group common directory. This takes place in the same Search field that 
is used for both a local and presence-enabled contact list search. The various directories have different 
purposes with the enterprise directory having the most data, and not all directories may be used in all 
deployments. All search results are combined into one common set of results. 

Personal directory, enterprise common, and group common directories cannot be modified from the 
client side. Only read access is provided. A snapshot of the presence status of the contact in the results list 
is shown, but this presence is not updated after the search operation. 

Personal directory provides your own special contacts that are not in the enterprise directory, for 
instance, partner company’s numbers while group common contains, for example, the group’s contacts 
such as favorite pizza taxi. 

FusionWorks UC One automatically searches the local contacts and presence-enabled contact list in 
addition to the enterprise and other directories at the same time. As soon as there are results from the 
enterprise and other directories, these results are shown on a separate list in the Main window. 
Additionally, there may be other search result groups from other search sources such as LDAP or Outlook. 

Search results are displayed differently depending on the results of the contact list and directory search: 

• If LDAP search (Corporate directory) or Outlook search are enabled, there are more result groups.

• If there are no results for a certain search source (for example, local contacts, Outlook, LDAP, or
MegaPath Telephony Directory), then that group is different in the UI.

The enterprise directory searches all available fields for the search string. By default, it waits for 1.5 
seconds before it sends the search request to the server to minimize unnecessary load on the server. 

Search results show the phone number to better distinguish between similar results. ToolTips are also 
provided for search results. 

Outlook integration (search and calendar integration) on Windows requires one of the following versions 
installed on the desktop: 

• Outlook 2010

• Outlook 2013

• Outlook 2016

Outlook search also works when several Outlook accounts are in use, but only one account is used at a 
time (default selected, which can be changed in Outlook). 

Additionally, other related considerations are as follows: 
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• The client searches for contacts and calendar entries in the default Outlook account. The account
is set to the default via File → Info (left pane) → Account Settings → Account Settings → Data
Files. Select an account and mark it as “Set as Default”. After making this change, sign out and sign
back in to the client and it now searches that account for contacts and calendar entries.

• The client searches the Outlook contacts only on the local machine (that is, the Outlook Address
Book). There is no Exchange server lookup performed. In addition, all directories in Outlook are
searched for contacts, even deleted folders. The Contacts directory can also have multiple levels
of subfolders.

Every minute, FusionWorks UC One reads Outlook appointments. If there is an appointment running at 
the current time, then the presence is shown as Busy – In Meeting. Overlapping appointments are also 
handled. Following are some examples of FusionWorks UC One operation with Outlook when time is 
9:10 A.M. 

• There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy – In Meeting.

• Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as Available.

• In the next minute, FusionWorks UC One again reads the appointments and sees that “A”
meeting is running; however, the presence was already explicitly marked as Available and
presence is not shown as Busy – In Meeting but Available.

• There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence is shown as Busy – In
Meeting when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as Busy – In 
Meeting until the next time Outlook appointments are checked (once every minute) and after that, 
presence is shown as Available. This change may be instantaneous or it may take a minute depending on 
how close the timer is to being triggered. 

The presence update is only triggered by appointments and meetings that are either accepted by the user or 
made by them. All day meetings do not trigger a presence change to Busy – In Meeting. 
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10 Full Enterprise Directory 

FusionWorks UC One allows for browsing of an entire enterprise directory. Click the Directory button 
on the left-hand side of the navigation pane. 
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11 Communications History 

The third and fourth icons from the top in the Main window on the left-hand side of the navigation pane 
displays your Chat and Call history respectively.  

Double-clicking a conversation on the chat tab list opens it in a new window, while double-clicking a call 
history item calls that number. Clicking a visual voice mail downloads the message so you can play it. 

FusionWorks UC One saves a call history for placed, received, and missed calls. The call history makes it easy 
for you to redial and call back when you have missed a call or you want to easily dial a contact with whom 
you have recently spoken. Each call has a separate entry in the list. 

Chat history for group chats, both in My Room and in instant group chat, are stored locally on the Desktop 
client, just like in one-to-one chat, but only for the time the user is joined into the session. Look at individual 
chats by double-clicking the contact in the contact list or click the chat history icon in the left pane. 

Double-click on a name in the list to call back directly (this calls back the same way you previously spoke, for 
example, if you were in a video call, double-clicking starts a new video call). Double-clicking an incoming call 
item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Communication History missed communications badges can be cleared by using the right-click menu from 
the Communication History button on the left pane (native Desktop only). The menu provides options to 
mark “All as viewed”, “Chats as viewed”, “Voicemails as viewed”, and “Calls as viewed”. 
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12 Voice Manager 

Click the Fusion Voice Manager icon to open a new web browser window containing the Voice Manager 
access screen. Click the Open Voice Manager button.  

For information on using Fusion Voice Manager, please visit the Fusion Support at 
www.fusionconnect.com/support. 

http://www.megapath.com/vlc
https://www.fusionconnect.com/support
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13 Outlook Add-In 

13.1 Introduction 

The Outlook Add-in for FusionWorks UC One provides integration between FusionWorks UC One 
Desktop and Microsoft Outlook and Microsoft Skype for Business (S4B). 

With this add-in, you can have Microsoft Outlook display FusionWorks UC One contact presence and 
invoke FusionWorks UC One functions like Chat, Call from Computer, Call from Phone, and Video Call 
from within Outlook. 

Depending upon your settings, Presence, Chat, and SIP Calls are executed from either FusionWorks UC 
One or Skype for Business. 

13.2 Supported Platforms 

The following platforms are supported: 

 Microsoft Outlook 2010 (32 and 64-bit), Microsoft Outlook 2013 (32 and 64-bit), and Microsoft 
Outlook 2016 (32 and 64-bit). See the following note for exceptions.

 Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and Microsoft Windows 10

 FusionWorks UC One Release 20.2.0.x or higher officially supported version.

NOTE: The current version of this add-in cannot be used if you have Microsoft Office 
Communicator or Skype installed. You must uninstall these products if you want to use 
this add-in. Skype for Business can be used at the same time. 

The following third-party components must be installed for the add-in to function correctly: 

 Microsoft .NET Framework 4 Client Profile

 Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime

These components are downloaded and installed by the installer if they are not found. They should not be 
uninstalled, as the add-in cannot functional correctly. Additionally, for Outlook 2016 and the Outlook Add-in 
(OL2016 Add-in), there are further considerations as follows: 

 The Outlook Add-in can only be installed by an administrator.

 If an administrator installs for all users and a normal user starts using the OL2016 Add-in, 
FusionWorks UC One needs to start before Outlook.

 For logging to work normally, FusionWorks UC One needs to start before Outlook.

 Every logging level change requires a restart of both FusionWorks UC One and Outlook for changes to 
take effect. This should be quite rarely needed.
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 If Outlook is closed while FusionWorks UC One is running, FusionWorks UC One needs to be restarted
as well for the Outlook UI to behave as expected.

 FusionWorks UC One lists connected components as extensions, if connected is NO or if component
version number is something other than 10.2.1.29, or both presence GW and add-in are not listed, an
error has occurred. Component is visible under Options → Add-ins → UI, which displays registered and
working add-ins on top, below stopped or non-working ones.

 If both are listed and show connected is YES, but the Outlook UI does not work, restart both apps.

 For Outlook upgrade requirements, see Section 13.5 Installation.

 For Outlook 2010, all contacts must be updated to have a SIP address. For Outlook 2013/2016, the
following applies:

o The SIP address does not need to be entered for the contacts, as long as there is an email
address that matches the Outlook contact. The same value is looked for in the SIP address
field, but it is probably more practical to have it in the email address.

o The Outlook Add-in allows you to choose which number to call.

NOTE: FusionWorks UC One must be installed with administrator privileges in C:\Program 
Files OR the C:\Program Files (x86) folder. 

13.3 Log Files 
Log files for the Add-in are located in the FusionWorks UC One log directory. You can open the folder via 
Options --> Advanced by clicking on the Show logs button. Outlook Add-in logging is turned on when 
FusionWorks UC One logging is enabled.

13.4 Windows Registry Entries 

The following table lists all the registry entries added or modified by the installer. 

Path Key Comment 

wnd Keeps Outlook applications window 
reference. 

HKEY_CURRENT_USER\Software
\FusionConnect\OutlookPlugin

LoggingLevel Logging level for Outlook plugin 
components. Its value as per FusionWorks 
UC One
→ Advanced logging selection as follows:
Basic logging on: 0x00000003
Detailed logging on: 0x00000005

HKEY_CURRENT_USER\SOFTWARE
\FusionConnect\FusionWorks UC 
One
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Both off: 0x00000000 

HKEY_CURRENT_USER\Software
\FusionConnect \ 
InstalledBrandedBTBC 
Can also exist in HKEY_LOCAL_  
MACHINE (even under Wow6432Node).

Example, 
OutlookPluginPath, 
CompanyName, 
ProductName 

These keys affect where the plugin is 
searched for when starting and where log 
files are written. 

HKEY_LOCAL_MACHINE\Software\
Microsoft\Office\Outlook\Addins\
FusionWorks UC One Add-in for Outlook

LoadBehavior 0x00000003, based on this value Outlook 
loads the add-in dll. 

HKEY_LOCAL_MACHINE\Software\
Microsoft\Office\Outlook\Addins\
FusionWorks UC One Add-in for Outlook

Description FusionWorks UC One Add-in for Outlook. 

HKEY_LOCAL_MACHINE\Software\
Microsoft\Office\Outlook\Addins\
FusionWorks UC One Add-in for Outlook

FriendlyName FusionWorks UC One Add-in. 

HKEY_LOCAL_MACHINE\Software\
Microsoft\Office\Outlook\Addins\
FusionWorks UC One Add-in for Outlook

Manifest $INSTDIR\plugins\Outlook$nO 
utlookBitness\UC-Outlook- 
addin.vsto|vstolocal 

HKEY_CURRENT_USER\Software\I
M Providers 

DefaultIMApp FusionWorks UC One 

HKEY_CURRENT_USER\Software\I
M Providers\FusionWorks UC One 

UpAndRunning 0x00000002 

HKEY_LOCAL_MACHINE\SOFTWARE\I
M Providers\FusionWorks UC One 

FriendlyName BroadsoftIMApp 

HKEY_LOCAL_MACHINE\SOFTWARE\I
M Providers\FusionWorks UC One 

GUID {E3D1613A-93B2-4237-B4B8- 
B50595462C25} 

HKEY_LOCAL_MACHINE\SOFTWARE\I
M Providers\FusionWorks UC One 

ProcessName presencegw.exe 

HKCU\Software\IM UC-One Application Needs to be taken by FusionWorks UC One 
Providers\DefaultIMApp name to be able to call. For example PSTN

numbers from Outlook. 

Figure 4 Registry Entries 

13.5 Installation 

The Outlook Add-in installation is integrated with the FusionWorks UC One installation. There is a check 
box in the installer to enable the Outlook Add-in installation. If Outlook is upgraded, the Outlook Add-in 
must be re-installed, since the Add-in uses different files depending on the Outlook version. 

The Outlook Add-in installation requires administrator rights to the computer for all Outlook versions. 
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13.6 Features 
13.6.1 Presence in Outlook 

The Outlook Add-in displays the presence of a contact in Outlook. Presence information is retrieved from 
FusionWorks UC One and is displayed as an icon next to the contact in emails and calendar appointments. 
The following is an example of an email with the To, From, and Cc fields showing presence for various 
contacts. 

Figure 6 Presence Displayed in Outlook 

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following figure. 

Figure 7 Presence Values in Outlook 

NOTE: You must be signed in to FusionWorks UC One for the presence to be displayed. 
Additionally, presence is only shown for contacts who have a valid SIP address and are 
in your Contacts list in FusionWorks UC One. 
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13.6.2 Contact Actions in Outlook 

Right-click on an email in your Inbox and call or chat with the sender using FusionWorks UC One. You 
have the option to Chat, Call (from Computer), Call from Phone, or Video Call as shown in the following 
figure. 

Figure 8 Contact Options in Outlook 

NOTE: Some of these options may not be available for all contacts. The Chat option is 
only applicable to contacts that are in FusionWorks UC One. Call options are applicable to all 
contacts as long as they have a valid phone number. 

These contact actions are also available on a contact card as shown in the following figure. 
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Figure 9 Contact Card in Outlook 

13.6.3 Call Multiple Numbers Configured for FusionWorks UC One / Non-FusionWorks UC One 
Contacts 

You can call any of the multiple phone numbers present in the Outlook contact card. This feature is 
available from received mail context menu, flagged mail context menu, and Contact’s context menu. You 
can also call the selected phone number via Call, Call from Phone, and Video Call. 

However, you cannot call multiple numbers for contacts stored on the FusionWorks UC One client or 
contacts in LDAP (AD) directories; only numbers stored in Outlook. 

See the following figure for an example of how to make the call from a received mail context menu. 

Figure 10 Received Mail Context Menu in Outlook 
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See the following figure for an example of how to make the call from the contact item context menu. 

Figure 11 Contact Item Context Menu in Outlook 

13.6.4 Uninstall Outlook Add-in for FusionWorks UC One Uninstall is done jointly with 
uninstallation of FusionWorks UC One. 
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14 FusionWorks UC One Add-In for Microsoft Skype for Business 

FusionWorks UC One supports integrating with Microsoft Skype for Business (S4B) (native Desktop 
only). The intended main use case is using FusionWorks UC One for non-S4B calls such as calls to mobile 
while presence, chat, and S4B-to-S4B calls still take place via S4B. In Release 22.2.0 and later, a custom 
menu is available on the S4B side used to make PSTN calls. 

Existing S4B integration with, for example, SharePoint, Office 365, and Internet Explorer can be used so 
that calls can be made from those applications. 

Usual FusionWorks UC One Call Control features such as hang up, mute, transfer, conference, and Call 
Park are supported. FusionWorks UC One call logs and call settings are also available in this configuration. 

FusionWorks UC One also updates phone presence on the S4B side. 
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15 Options 

Options provide access to available settings for FusionWorks UC One. Follow these steps to access 

Options. Windows and OS X 

1. Click the Options icon in the Main window left pane (bottom) or use the top navigation bar File
→ Options

2. Selected the desired section from the drop down menu. Sections are General, Audio/Video,
Incoming Calls, Outgoing Calls, Extensions, and Advanced.

15.1 General 

Language 
Select your language then click OK or Apply and the change takes effect immediately.  

Login 
Enable or disable automatic login when starting the application and control the remember password feature 
as well as enable the Update Password feature. 

Notifications 
Usually there is a confirmation pop-up notification each time you remove a contact or chat history record. By 
selecting one or all of the check boxes, you can disable the confirmations when deleting information. You can 
also control whether there is always a pop-up notification for publishing location information. Typically, this is 
shown at login. 

You can also select whether to receive a notification before ending communication or holding a call. 

Accessibility 
Enable pop-up errors allows FusionWorks UC One error pop-ups to be shown in addition to the usual error 
text shown at the top of the Main window. 

Enable ToolTips is enabled by default. For accessibility, screen reader/Voice over reads all ToolTips, which may 
be frequent and hence disturbing. For this reason in accessibility cases, it is recommended to disable ToolTips. 

You can also enable spell checking and auto-capitalization. 

15.2 Audio/Video 
15.2.1 Audio 

Headset 
Here you can specify the output and input devices used for the headset when toggling between headset and 
speakers. 
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Output Device (Device Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external playback 
device is selected by default (if you have none connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for voice during calls. 
You external recording device is selected by default (if you have one connected). You can also choose 
automatic gain control and test your recording device. 

Speakers 
Here you can specify what are the output and input devices used for speakers when toggling between the 
headset and speakers. 

Ring Device (Alert Signal) 
Select the audio device that is played when you receive an incoming call. 

Ring Signal 
You can select your own ring signal. The same signal is used for both voice and video calls. 

You can also select an icon to play a tone for incoming messages. To disable the tone, uncheck the icon. 
Select a sound event and then click Play to hear the sound. 

15.2.2 Video 

Capture Device (Video) 
Select a camera that you want to use for video calls. Your external web cam is selected by default (if you 
have one connected). 

Video Size 
Select one of the available sizes. Note, however, that higher sizes require more bandwidth and a more 
capable central processing unit (CPU). 

Click Test Call to make a test call to test voice quality. 

15.3 Incoming Calls 

For the list of available call management services for incoming calls, see Section 17 – Call Settings. 

15.4 Outgoing Calls 

For the list of available call management services for outgoing calls, see Section 17 – Call Settings. 

15.5 Extensions 
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Select how incoming add-in requests are handled, whether they are automatically accepted or not or if 
incoming requests are allowed at all. 

Depending on your service provider configuration, you can also manage extensions using the FusionWorks UC 
One Application Programming Interface (API), which is used by third-party applications such as the Outlook 
Add-in or compatible headsets. You can allow such third-party applications to obtain information from 
FusionWorks UC One and enable or disable confirmation pop-up notifications when third-party applications 
request information from FusionWorks UC One. You can also choose default behavior to always reject or 
accept requests from third-party applications and allow or reject individual third-party applications. 

The following logic applies for accepting application requests: 

 Every new first-party application is allowed to connect without user interaction.

 Every new third-party application opens a dialog asking for permission to connect. Your response is
remembered (both negative and positive responses).

15.6 Advanced 

The Advanced view contains two different subsections: 

 Troubleshooting

 Proxy

Troubleshooting 
Logging is used for troubleshooting. You may be asked to turn on logging and then send a log file directory 
contents. You can choose basic logging or more detailed logging to be enabled. Detailed logging may 
consume memory resources so it is not recommended to have it enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable Google Analytics. 

Proxy 
Select how to handle HTTP proxies. By default, the system settings are used but you can also choose not to 
use an HTTP proxy or to use the FusionWorks UC One (client) proxy settings. 
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16 Call Settings 

FusionWorks UC One supports the following service management features allowing supplementary 
services to be managed using the Options and Incoming Calls and Outgoing Calls view available in the 
Main window left pane by selecting the appropriate sub-view in the drop-down: 

 Incoming calls

o Do Not Disturb

o Call Forwarding

o Simultaneous Ring

o Remote Office

o Call Waiting

o Fusion Anywhere

You can also use the Calls navigation in the Main Navigation bar. 

16.1 Do Not Disturb 

When you activate this service, all calls are typically blocked by the server and are sent to voice mail. 
Enable this service by enabling the service icon. 

16.2 Forward Calls 

Enter a number to which your calls should be forwarded. Different variants of Call Forwarding are 
supported, such as forwarding always, forwarding when busy, and forwarding when you cannot answer 
or when you are unreachable. In addition, you can specify the number of rings before Call Forwarding is 
triggered. 

16.3 Simultaneous Ring 

Add up to ten additional numbers that you would like to ring in addition to your primary number when you 
receive a call. In addition, specify whether you want answer confirmations and if you would like to receive 
calls when already on another call.  

16.4 Remote Office 

This service allows the user of any phone as the office phone from a charging and numbering 
perspective. For instance, a hotel room phone can be used as the office phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be used as the 
Remote Office number. 
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16.5 FusionWorks UC One Anywhere 

Fusion Anywhere simplifies communications for on-the-go users and remote users by extending the 
features of a desk phone to any other fixed or mobile device, regardless of the network or handset 
manufacturer. Callers dial one number and can reach you on any phone the user chooses. A desk phone, 
cell phone, and/or a soft phone may ring simultaneously. 

Experience voice call continuity with the ability to move live calls from one device to another without 
hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field. Use the Alert all 
locations simultaneously check box to activate parallel ringing. Click on the “+” icon to see more options. 

The Do Not Divert Calls / Do Not Forward check box prevents a call from ending up as a voice mail, which 
can be problematic in, for example, conference call situations. 

Select Answer Confirmation to receive a separate audio prompt when answering a call from that number 
(location). It may be useful in cases where, for example, mobile numbers are being used to prevent 
incoming calls going to mobile voice mail since the call will be ended without going to voice mail if the 
answer confirmation is not provided. 

Select the Call Control check box to enable the server platform to provide mid-call services such as Call 
Transfer and Conferencing for that number (location). 
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17 Sign Out 

Signing out of FusionWorks UC One sets your status to “Offline” for your contacts and displays the Sign In 

screen. 17.1 Sign Out of FusionWorks UC One 

To sign out, follow these steps. 

Windows 

1. Select File from the main menu.

2. Select Sign Out.

OS X 

1. Select Actions from the main menu.

2. Select Sign Out.

17.2 Exit Application 

To exit the application completely, follow these steps. 

Windows and OS X 
Close the Sign In window. 

Windows 

1. Select File from the main menu.

2. Select Exit FusionWorks UC One.

OS X 

1. Select FusionWorks UC One from the main 
menu.

2. Select Quit FusionWorks UC One.

NOTE: Closing the Main window (not the Sign In window) does not exit the application 
but rather minimizes the application to the system tray (Dock). This allows you to 
continue to receive calls and messages without having the Contacts list window 
appearing on the desktop. 
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18 Multi-Device Support 

FusionWorks UC One supports users with multiple devices, according to the XMPP specifications. 
This is comprised of several features: 

 Chat invitations sent to a user are received on all devices. Once a particular device has been used
to answer the chat invitation, subsequent incoming messages only go to that device.

 One can retrieve one’s own presence notifications when another client updates the user’s
presence. The client stores this information and updates its own presence so that it is the same as
the higher priority status it received, (that is, when the received status update is manual). If the
received presence update is not manual, it does not react to the received update; it only notes it.

 Accepting a sharing presence invitation in one client is also recognized by another client, and both
clients start receiving presence updates.

 Last sent and received messages are available on all devices when the optional message history
feature is in use. All devices should use that feature at the same time to avoid duplicate messages.

 Missed chat badges are synchronized across all own devices when this preview feature is enabled.

 A new presence subscription made in one client is recognized in another. If the contact declines
the “invitation”, there are presence notifications from the server to all of the user’s clients
indicating that the subscription was terminated and this information is shown to the user. If the
client receives two presence authorization requests from two or more devices for the same user, it
only shows one request to the user.

 Removing a contact from the contact list in one device is recognized in another client and the
contact list is updated (that is, the contact is removed) in the other client as well.

If a user has many devices, each device has the same status when shown to the end user. In addition, the 
contacts on the contact list always see the same status with updates shown in the following priority order: 

 Busy

 Online

 Away

 Offline

This means, for example, that if one client publishes a Busy status and another client publishes another 
status, contacts see the user as Busy. Compatible devices such as desk phones are able to show presence 
in the same way. 
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19 Installation 

The installer supports a number of options on Windows (native Desktop only) as follows: 

 Agree to the license agreement.

 Run when system starts (can be changed later in Options).

 Install Outlook Add-in.

 Install S4B integration

 Modify Windows registry to enable S4B dial pad.

 Create a desktop icon.

 Select destination folder for installation.

 Select the name of the software in the Program menu.

 Launch the client after installation.

When installer has been run on an end user’s behalf by an administrator, the “Run program when system 
starts” option cannot be changed by that end user. 

If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and 10) or from 
msconfig.exe on Windows 7, the change is not reflected in Options. The check box remains checked and grey 
even though the client is not actually started automatically when the system starts. 

When FusionWorks UC One is installed for the first time, you can choose the language if many languages are 
supported in the installer. The default language is the language of the operating system; if that cannot be 
found, English is used as the fallback. 
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20 Uninstallation 

The uninstallation procedure is different for Windows and OS X. 

20.1 Windows 

Uninstallation is performed by launching the Windows uninstaller via the Start menu or by using the 
Windows “Remove programs” view inside the Control Panel. Windows uninstallation does not require 
you to select any options. The language used for the Windows Start menu string “Uninstall” is taken from 
the language chosen when installing the client. This string cannot be changed after installation. 

All files are deleted at uninstallation, except for the following files: 

 Registry entries

 Account files are only deleted when explicitly allowed by the end user on Windows.

20.2 OS X 

Uninstalling is performed by simply dragging the application folder from the Applications directory to the 
trash can; however, account files are not deleted. If you want to remove account files, they must be 
manually deleted. These are the file locations for the account directories. The following locations apply for 
all account directories: 

For branded clients: 
/Users/<USERNAME>/Library/Application Support/<company_name>/<application_name> 

For the reference client: 
/Users/<USERNAME>/Library/Application Support/BroadSoft/FusionWorks UC One 
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21 System Requirements 

System requirements are as follows on native Desktop: 

 Operating system: Mac OS 10.11 El Capitan, Mac OS 10.12 Sierra, Mac OS 10.13 High Sierra, Windows
7 SP1, Windows 8/8.1, or Windows 10 (Classical view only).

 The installation footprint is approximately 125 megabytes (MB) on OS X and 215 MB on Windows.

 For voice calls, a sound card, speakers, and a microphone or a headset are required.

 For video calls, a web cam is required.

Minimum system requirements for respective operating systems need to be fulfilled, with the following 
additions: 

 A minimum of 2 GB random access memory (RAM) is required.

 A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended for video calls at a
minimum.

 Open Graphics Library (OpenGL) 1.5 or higher is recommended.

For high definition (HD) video, the following is recommended: 

 HD camera

 HD resolution support in display

 Quad Core x86 or equivalent at a minimum

 4 GB RAM

VDI environments are not supported. 
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22 Appendix A: Keyboard Shortcuts for Desktop 

The following table lists the currently supported keyboard shortcuts (native Desktop only). You can use 
these keyboard shortcuts to quickly perform frequently used actions. The characters used are lower case. 
The shortcuts are also indicated in the accessibility menus. 

Shortcut for 
Windows Shortcut for Mac What it does 

CTRL-Q Cmd-Q This quits the application. 

Alt+F4 Cmd-W This closes the selected window (except for a 
contact card and the About window). 

CTRL+C Cmd-C This copies selected text from FusionWorks UC One to the 
clipboard. 

CTRL+V Cmd-V This pastes text from the clipboard to the location 
selected using the cursor in FusionWorks UC One. 

CTRL-X Cmd-X This cuts the selected text to clipboard. 

Enter Enter 

When in the Communications window, this sends a 
chat message (if the Chat view is visible). 

When in the contact list, this opens a chat with the 
selected contact. 

When in the Communications History, this opens a 
communications session with the contact or address 
related to the selected item. This opens a chat if the 
item was chat and a call if the item was a call. 

-, Cmd-, This opens Options. 
F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat view. 
- Cmd-H This hides FusionWorks UC One. 

- Alt-Cmd-H This hides other windows other than FW UC One

CTRL-N Cmd-N This opens the Add Contact window. 
Shift-CTRL-N Shift-Cmd-N This opens the Add Group window. 

CTRL -1 Cmd-1 When a contact is selected, this opens a chat session 
with the contact. 

CTRL -2 Cmd-2 When a contact is selected, this calls the contact 
with audio. 

CTRL -3 Cmd-3 When a contact is selected, this calls the contact 
using call from phone. 

CTRL -4 Cmd-4 When a contact is selected, this calls the contact 
with video. 

CTRL -5 Cmd-5 When a contact is selected, this joins their room. 

CTRL -6 Cmd-6 When a contact is selected, this opens an email-
sending window using the default email client. 
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CTRL -I Cmd-I When a contact is selected, this opens the contact 
card for the contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a 
favorite. 

CTRL-delete Cmd-delete This deletes the selected contact. 
CTRL-arrow down Cmd-arrow down This decreases the volume. 

CTRL-arrow up Cmd-arrow up This increases the volume. 
CTRL-space CTRL-space This mutes the client (while in a call). 

CTRL-D Cmd-D This turns on the Do Not Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from your other device to 
FusionWorks UC One. 

Alt-shift- CTRL-P Alt-shift-Cmd-P This retrieves your parked call. 
- Alt-Cmd-2 This calls your voice mail with audio. 

- Alt-Cmd-3 This calls your voice mail with audio using call from 
phone. 

- Alt-Cmd-4 This calls your voice mail with video. 
Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on OS X. On Windows, it 
only is used for the Team Telephony window. 

CTRL-T Cmd-T This enables always on top. 
- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 
Shift-CTRL-F2 Shift-Cmd-F2 This opens call history. 
Shift-CTRL-F1 Shift-Cmd-F1 This opens chat history. 
Shift-CTRL-F3 Shift-Cmd-F3 This opens visual voice mail. 
Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 
Shift-CTRL-W Shift-Cmd-W This opens the web button view. 

Figure 12 Desktop Shortcuts 
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23 Appendix B: Configure USB Headsets 

This section provides more information on configuring USB devices to function with FusionWorks UC 
One. Note that some headset manufacturers have built their own add-ins for FusionWorks UC One, for 
instance, Jabra on Windows. In this case, the standard HID Add-Ins cannot be used at the same time. You 
can enable and disable add-ins in the Options → Extensions view. 

In general on Windows, if “Default Communication Device” is defined in Windows settings, it is selected 
over the “Default Device” by FusionWorks UC One for calls when several audio devices are available (for 
example, USB headset and the integrated audio device on the PC). However, when using headsets, you 
can select a separate device than the headset for alerting incoming calls. 

The following examples provide more information on how to define a default communications device 
when a USB headset is available on the PC. 

It is recommended to select “Use Default” in the Audio/Video section of FusionWorks UC One Options 
for both input and output devices (as shown in the following figure). 

Figure 13 Options → Audio/Video Settings 
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1. To define the default communications device,
make sure that the Sound settings in Windows
pertaining to “Recording” and “Playback”
devices are correctly configured. From the
Sound applet, select the Playback tab.

Figure 14 Playback Tab 

2. Click Headset Earphone to highlight the
device and click on the drop-down arrow
next to Set Default button.

Figure 15 Playback Tab Set Default 

3. Select Default Communication Device. The
following screen is displayed.

Figure 16 Playback Tab 

4. Click the Recording tab.

Figure 17 Recording Tab 

5. Click Headset Microphone, which represents the
connected Plantronics BT300M device, and click
the drop-down arrow next to the Set Default
button.

Figure 17 Recording Tab Set Default 

6. Select Default Communication Device.
7. Click OK to save the changes. The Sound 

window is dismissed and your device is 
now ready to be used by FusionWorks 
UC One.

Figure 18 Recording Tab 
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24 Appendix C: Third-Party Software and Copyright 

The following third-party software is used in FusionWorks UC One. 

Chromium 

Copyright (c) 2013 The Chromium Authors. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution. * Neither
the name of Google Inc. nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

WebRTC 

Copyright (c) 2011, The WebRTC project authors. All rights reserved. 

* Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Google nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

OpenH264 

Copyright (c) 2013, Cisco Systems. All rights reserved. 

OpenH264 License: https://github.com/cisco/openh264/blob/master/LICENSE 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Blowfish 

Based on a C implementation of the Blowfish algorithm by Paul Kocher UUID - RFC4412 
/* 
** Copyright (c) 1990 - 1993, 1996 Open Software Foundation, Inc. 
** Copyright (c) 1989 by Hewlett-Packard Company, Palo Alto, Ca. & 
** Digital Equipment Corporation, Maynard, Mass. 
** Copyright (c) 1998 Microsoft. 

** To anyone who acknowledges that this file is provided "AS IS" without any express or implied warranty: 
permission to use, copy, modify, and distribute this file for any purpose is hereby granted without fee, 

https://github.com/cisco/openh264/blob/master/LICENSE
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provided that the above copyright notices and this notice appears in all source code copies, and that none 
of the names of Open Software Foundation, Inc., Hewlett-Packard Company, Microsoft, or Digital 
Equipment Corporation be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Neither Open Software Foundation, Inc., Hewlett-Packard 
Company, Microsoft, nor Digital Equipment Corporation make any representations about the suitability 
of this software for any purpose. 
*/ 

MD5 

Copyright (c) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. 

License to copy and use this software is granted provided that it is identified as the “RSA Data Security, 
Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this software or this 
function. 
License is also granted to make and use derivative works provided that such works are identified as 
“derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or 
referencing the derived work. 

RSA Data Security, Inc. makes no representations concerning either the merchantability of this software 
or the suitability of this software for any particular purpose. It is provided “as is” without express or 
implied warranty of any kind. 

SHA-1 

Copyright (c) The Internet Society (2001). All Rights Reserved. 

This document and translations of it may be copied and furnished to others, and derivative works that 
comment on or otherwise explain it or assist in its implementation may be prepared, copied, published 
and distributed, in whole or in part, without restriction of any kind, provided that the above copyright 
notice and this paragraph are included on all such copies and derivative works. However, this document 
itself may not be modified in any way, such as by removing the copyright notice or references to the 
Internet Society or other Internet organizations, except as needed for the purpose of developing Internet 
Standards in which case the procedures for copyrights defined in the Internet Standards process must be 
followed, or as required to translate it into languages other than English. 

The limited permissions granted above are perpetual and are not revoked by the Internet Society or its 
successors or assigns. 

This document and the information contained herein is provided on an “AS IS” basis and THE INTERNET 
SOCIETY AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTY THAT THE USE OF THE INFORMATION HEREIN 
WILL NOT INFRINGE ANY RIGHTS OR ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

SQLCipher 
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Copyright (c) 2008-2012 Zetetic LLC All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the ZETETIC LLC nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY ZETETIC LLC ''AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
ZETETIC LLC BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Lesser General Public License (LGPL) 

The following third-party libraries are in use based on LGPL license. 

This software uses Qt libraries licensed under the GNU Lesser General Public License (LGPL) 2.1. 
Qjson – Copyright 2012 – Flavio Castelli 
QXmpp – Copyright 2008-2011 The QXmpp developers 
QCA – Copyright 2003-2007 Justin Karneges justin@affinix.com. Copyright 2004-2006 Brad Hards 
bradh@frogmouth.net 

LGPL license are available at http://www.gnu.org/copyleft/lesser.html. 
LGPL license is also available locally with this software, at the installation directory. 

BSD license 

The following software is used based on BSD license: OpenSSL - Copyright 1998-2011. The OpenSSL Project. 
License available at http://www.openssl.org/source/license.html. 

Breakpad - Copyright 1998, Regents of the University of California Breakpad license available at 
http://opensource.org/licenses/BSD-3-Clause. Stackwalker - Copyright 2009, Jochen Kalmbach 
License available at http://stackwalker.codeplex.com/license. 

mailto:justin@affinix.com
mailto:bradh@frogmouth.net
http://www.gnu.org/copyleft/lesser.html
http://www.openssl.org/source/license.html
http://opensource.org/licenses/BSD-3-Clause
http://stackwalker.codeplex.com/license
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Apache license 2.0 

The following third-party libraries are using Apache license 2.0: Log4cxx - Copyright 2012 Apache Software 
Foundation. 
License available at http://logging.apache.org/log4cxx/license.html. 

Non-restrictive license 

The following third-party library is used based on its own non-restrictive license: OpenLDAP - Copyright 2013, 
OpenLDAP Foundation. 

OpenLDAP license is available online for review at http://www.openldap.org/software/release/license.html. 
OpenLDAP license is also available locally with this software at the installation directory. 

Free software 

The following free software is only used when third-party software is using the FusionWorks UC One API via 
LGPL, MIT, BSD, or another license: 

Tufao (LGPL2.1) – Copyright 2012 Vinicius dos Santos Oliveira vini.ipsmaker@gmail.com Libcurl – Copyright 
1996 - 2013, Daniel Stenberg, daniel@haxx.se 
License available at http://curl.haxx.se/docs/copyright.html. Tinythread++ - Copyright 2012 Marcus Geelnard 
License available at http://opensource.org/licenses/zlib-license.php. 

Picojson – Copyright 2009-2010 Cybozu Labs, Inc. Copyright 2011 Kazuho Oku License available at 
https://github.com/kazuho/picojson/blob/master/LICENSE. Easywsclient – Copyright 2012, 2013 
dhbaird@gmail.com 
License available at https://github.com/dhbaird/easywsclient/blob/master/COPYING.  
The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd. 
Contact: http://www.qt.io/licensing/ 
You may use, distribute and copy the Qt GUI Toolkit under the terms of GNU Lesser General Public License 
version 3. 
This license makes reference to version 3 of the GNU General Public License. LGPL license are available at 
http://www.gnu.org/copyleft/lesser.html. 

EmojiOne 

Emoji artwork provided by EmojiOne. http://emojione.com 

http://logging.apache.org/log4cxx/license.html
http://www.openldap.org/software/release/license.html
mailto:vini.ipsmaker@gmail.com
mailto:daniel@haxx.se
http://curl.haxx.se/docs/copyright.html
http://opensource.org/licenses/zlib-license.php
https://github.com/kazuho/picojson/blob/master/LICENSE
mailto:dhbaird@gmail.com
https://github.com/dhbaird/easywsclient/blob/master/COPYING
http://www.qt.io/licensing/
http://www.gnu.org/copyleft/lesser.html
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25 Appendix D: Acronyms and Abbreviations 

This section lists the acronyms and abbreviations found in this document. The acronyms and 
abbreviations are listed in alphabetical order along with their meanings. 

Acronym Meaning 
ACB Automatic Callback 
ACD Automatic Call Distribution 
APR Application Programming Interface 
CPU Central Processing Unit 
DND Do Not Disturb 

DTMF Dual-Tone Multi-Frequency 
ECACS Emergency Call Address Change Service 
EULA End-User License Agreement 
FAC Feature Access Code 
FAQ Frequently Asked Question 
FIPS Federal Information Processing Standard 
FMC Fixed-mobile Convergence 
GUI Graphical User Interface 
GW Gateway 
HD High Definition 
HID Human Interface Device 
IM Instant Message 

IM&P Instant Messaging and Presence 
IP Internet Protocol 

LDAP Lightweight Directory Access Protocol 
LGPL Lesser General Public License 
MWI Message Waiting Indication 
PIV Personal Identity Verification 

RAM Random Access Memory 
S4B Skype for Business 
SIP Session Initiation Protocol 
SSO Single Sign-On 
UC Unified Communications 
UI User Interface 
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URL Uniform Resource Locator 
UVS Broadworks Video Server 
VDI Virtual Desktop Infrastructure 
VoIP Voice over IP 

WebRTC Web Real-Time Communication 
XMPP Extensible Messaging and Presence Protocol 

Xsi Xtended Services 
Figure 19 Abbreviations Table 
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